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Why are we here?

... and, why are we talking about packet?

Purpose
« City... provides services; promotes the common good
« EMS... = Prepares for disasters
= responds to minimize loss of life and property
» speeds the recovery
Needs
- EMS... = needs information... what’s going on out there?
= work with recovery partners and service providers
Capabilities

* What we bring...
= Volunteerism!... An interest to help out
= Communications
= Structure
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Why are we here?

... and, why are we talking about packet?

Capabilities... communications
Frequency agility

Different modes... voice, data, video
Bandwidth

Independence from commercial services

Simple Messages Complex Messages
Mode Voice Packet
Messages Short messages Lists, instructions, details
Delivery Immediate Store & forward; mail drop
Equipment Radio Radio + TNC+ PC + SW + BBS
Complexity Short learning curve  Many commands
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Why are we here?

... and, why are we talking about packet?

Mapping Capabilities to Needs

« City OES... message handling with field sites, etc.

« Santa Clara County OES... EOC-to-EOC message handling
« RIMS backup (PACRIMS)
« City Scan / Flash Report
« County Logistics Request Form

« Emergency Volunteer Centers

CAPABILITIES help fulfill NEEDS, that support PURPOSE
Is Packet a capability that could address other needs?

3
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Why are we here, really?

x
.

To dispel silly
myths about
packet radio!
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Myth #1
Setting up a packet station takes lots of time
and way too many cables and connectors.

. _;.—.:.5:.:33;'.1.;%-:;.:: s Ny ,. o Eol than R u b b i S h !

It’'s much easier than looking
for a needle. It takes only 3
boxes and two cables! Just
take a look!
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Packet — A Quick Overview
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Setting the Volume

Setting the Correct Volume is easy
as...

1. Turnon TNC

2. Turn on radio to lowest
volume setting. Turn squelch
setting to lowest setting.

3. Turn up volume until “receive”
light on TNC lights up. Go just a
little bit more.

4. Turn up Squelch until light
goes back out.

Outpost Packet Message Manager 2.1.2




Myth #2
Sending messages via packet is difficult and
requires learning all kinds of silly commands

B Nonsense!

If you can put on a set of
headphones and push a
button to talk, you will find
this easy! Just use Outpost!

\[.
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Overview

What is Outpost?

« A Windows-based packet messaging client

» Supports ARES, RACES, and other amateur radio emergency response
teams and their need to pass digital traffic

* Helps automate the packet message handling environment
 Manages all message handling between you and your BBS
» Lets you read, delete, create, reply to, or forward messages back to the BBS

Outpost is a software layer that provides a nice user interface to

the complex world of packet operations, TNC usage and BBS
commands
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Overview

Why use Outpost?

» Leverages the existing packet hardware, network, and BBS infrastructure
« Compatible with many existing BBSs and TNC PBBSs
» Uses your existing TNC and packet radio equipment
» Only a packet client (end-user) change is required
» Hides the complexity of the packet operating environment
 Similar look and feel to contemporary email programs
» Shorter learning curve for packet operations
* Allows users to... “focus on the message, not the medium”
* Implements most local emergency management policies for digital
communications

« Still under active development based on user requests and on-going
alignment with the Outpost mission.
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Overview

General Outpost Features

« Message Management
» Multiple message folders
» Supports the three primary message types: Private, NTS, and Bulletins
» Text Formatting in a free-form message window
* NTS Message Maker with automated ARL message support
* On-line report builder using report templates
» Supports Urgent message, Delivery and Read Receipts

« Send/Receive Session Management
» Supports Serial, AGWPE, and Telnet interfacing to a BBS
» Automatically controls the sequence for initializing the selected interface, connecting to,
and sending messages to and retrieving messages from the BBS

« Configurations and Setups
* BBS, TNC, and Interfaces — manages a list of BBSs & Interfaces
* Message Retrieval — choose the message types ti be retrieved
» Send/Receive automation — 3 ways for automatically initiating BBS sessions
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Topics

Features

Creating Messages

A Typical Session
Limitations and Constraints
Questions
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Features

_in
File Edit Setup Tools Actions Help k
Message management | opn| oo ]
» Familiar email-app look and feel _ _ _
InTra L | T_I,J|:|e| From | To | BES | Subject | D ated/Time | Slzel
niray B SYSOP ALLEOC W6XS_ EMERGENCY BBS OPER._ 02716704 16:54 51
° Separate f0|ders for message B NEVFH  ALL KEFB-2  SUNNYVALE Hah FLEAMAR. . (08/13/0412:33 2770
- CARES M5 Mask Prichase 12/27,014 17:4] 25
1 XSCEOC CUPED.. WEXS_ R t EOC Stat 12721704 23-49 249
Storage Hut Tray KNEFE  NEWUSA  KEFE2  Welome o Dutpos?1l_‘§ None 1443
KMEPE MEWUSH  KEFEB-2 What's Mew in Qutpost 1.3 Maone 4108
e Clearer messaae identification 5 T I e e AV e
14 e ! 1l 1¢ Li
g Msgs KNMEPE ~ NEWUSR  KEFB-Z  WHAT'S NEwW! Mi?srgZéc.:ny Nore 1445
(unread=BOLD, urgent=Red)
Archive
» Follows a formal message
Diraft
workflow e
« Manage BBS and interface Oeed
Setu pS | 9ltems, 35 Total | Station |D: KMEPE ~ THC: KPC-3 ~ BES: KEFB-2 00000 115748

« Additional settings to control
how Outpost behaves
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A Closer Look

Outpost Packet Message Manager
File Edit Setup Tools Actions Help

Newi Dpenl Delete! F‘rinti SendfF‘.eceive]
M Type I Fram I To I BES i Subject I DratedTime I Size!
B AABWE ALL KGFB-2 BMHA Bicycle Mobile Hams of ... 11/28/95 18-___ 399
B AABWE ALL KEFB-2 Met Preamble 03/18/93 21:._. 3660
B AABWE ALL KGFB-2 »>>» how to use the node and/or 0318793 21:__. 846
HE Ty B AAEWE, ALL KEFE-2 Welcome 0341892 21:20 1035
B KMEPE ALLUSR  KGFB-2 Cupertino ARES/RBACES 11/04/06 17:._. 246
B AAEWE, ALL KEFE-2 KEFE website, breakfast, net 1140405 18:53 261
B KEEBCW  ALL KEFE-2 Packet Tutorial URL 05/31/0019:28 173
Sent B SHCEOC SCCEDOC WEXSCA SMNCEQC-1 operational 0722408 14:52 J63
Mzgs B SHCEOC SCCEDOC WEXSCA drill 01-21-06 0142107 16:06 4B7
B SHYEOC ALLEOC WEXSCA Request to submit 2005 SET data 1041708 2348 1836
CUPEOC LOSED... WBXS5C-1 Welcome to outpost 03/20/07 14:._. 321
B LOSEDC ALL WEXSCA Test Bulletin from Loz Altoz 032007 14:21 249

Archive

Drraft
Magz

Deleted
a0z

[ , - \ -
[ [
tal | Station ID: NEJRC - Tactical Calt LOSEOC ~ TNC: KPC-3 - BBS: WEXSC-] /) 000000 131751
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¢




16

A Closer Look

Outpost Packet Message Manager
etup  Tools

Actions  Help

Dpenl Delete! F‘rinti SendfF‘.eceive]
In Tray
M Type I Fram I To I BES i Subject I DratedTime I Size!

B AABWE ALL KGFB-2 BMHA Bicycle Mobile Hams of ... 11/28/95 18-___ 399

B AABWE ALL KEFB-2 Met Preamble 03/18/93 21:._. 3660

B AABWE ALL KGFB-2 »>>» how to use the node and/or 0318793 21:__. 846

HE Ty B AAEWE, ALL KEFE-2 Welcome 0341892 21:20 1035

B KMEPE ALLUSR  KGFB-2 Cupertino ARES/RBACES 11/04/06 17:._. 246

B AAEWE, ALL KEFE-2 KEFE website, breakfast, net 1140405 18:53 261

B KEEBCW  ALL KEFE-2 Packet Tutorial URL 05/31/0019:28 173

Sent B SHCEOC SCCEDOC WEXSCA SMNCEQC-1 operational 0722408 14:52 J63

Mzgs B SHCEOC SCCEDOC WEXSCA drill 01-21-06 0142107 16:06 4B7

B SHYEOC ALLEOC WEXSCA Request to submit 2005 SET data 1041708 2348 1836

CUPEOC LOSED... WBXS5C-1 Welcome to outpost 03/20/07 14:._. 321

B LOSEDC ALL WEXSCA Test Bulletin from Loz Altoz 032007 14:21 249
Drraft
Magz

Deleted
a0z
12 Items, 20 Toatal iStatiu:unID: MEJRC - Tactical Call: .I:EISEEIE - THNC: KPC-3 - BES: WE<5CA iEIEI:EIEI:EIEI-!'IEI:'I?':E'I 7

(
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A Closer Look

Outpost Packet Messaoa Manacar

P tdit Setup Tools Actions Help
< Newi Dpenl

Delete! F‘rinti SendfF‘.eceive]

Ot Tray

Sent
Mags

Archive

Drraft
Magz

Deleted
a0z

M Type I Fram I To I BES i Subject I DratedTime I Size!
B AABWE ALL KGFB-2 BMHA Bicycle Mobile Hams of ... 11/28/95 18-___ 399
B AABWE ALL KEFB-2 Met Preamble 03/18/93 21:._. 3660
B AABWE ALL KGFB-2 »>>» how to use the node and/or 0318793 21:__. 846
B AAEWE, ALL KEFE-2 Welcome 0341892 21:20 1035
B KMEPE ALLUSR  KGFB-2 Cupertino ARES/RBACES 11/04/06 17:._. 246
B AAEWE, ALL KEFE-2 KEFE website, breakfast, net 1140405 18:53 261
B KEEBCW  ALL KEFE-2 Packet Tutorial URL 05/31/0019:28 173
B SHCEOC SCCEDOC WEXSCA SMNCEQC-1 operational 0722408 14:52 J63
B SHCEOC SCCEDOC WEXSCA drill 01-21-06 0142107 16:06 4B7
B SHYEOC ALLEOC WEXSCA Request to submit 2005 SET data 1041708 2348 1836

CUPEOC LOSED... WBXS5C-1 Welcome to outpost 03/20/07 14:._. 321
B LOSEDC ALL WEXSCA Test Bulletin from Loz Altoz 032007 14:21 249

12 ltkems, 20 Total iStatiu:unID: MEJRC - Tachcal Call: LOSEQOC - THC: KPC-3 - BBS: WE=SC-1

00:00:00

131751

A

2
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A Closer Look

Outpost Packet Message Manao-:

File Edit Setup Tools Agsefz Help
Me Dpenl Delete! F‘rinti SendfF‘.eceive]
Folder cist
| e 1 | Type | From | To | BBS | Subject | Date/Time | Size| N\
R B AABWK  ALL K6FE-2  BMHA Bicycle Mobile Hams of . 11/28/95 18:_. 399
"""""""" B AABWE ALL KEGFB-2 Met Preamble 03/18/93 21.... 3660
B AABWE ALL KGFB-2 »>>» how to use the node and/or 0318793 21:__. 846
Bt Tray B AbEWE, ALL k.EFB-2 Wielcome 0341893 21:20 1035
B KNGPE ALLUSR  KGFB-2 Cupertino ARES fBACES 1104706 17 246
] AbEWE, ALL k.EFB-2 KEFE website, breakfast, net 1104405 18:53 261
] FEEBCW  ALL k.EFB-2 Packet Tutorial URL 05/31/00 19:28 173
Sent B SHWCEDC SCCEOC WEASC-1  SMWCEOC-1 operational 0722406 14:52 363
Mzgs B SHCEOC SCCEOC WEASC-1 diill 01-21-08 /2107 16:06 467
B SWYEOC  ALLEODC WEASC-1  Feguest to submit 2005 SET data 10417406 2348 1836
CUPEOC LOSED... WEBXSC-1 Welcome to outpost 03/20/07 14-__. A
B LOSEQC ALL WEASC-1  Test Bulletin from Loz Altos 0320407 14:21 249
Drraft
Msgs
N
Deleted
a0z
12 Items, 20 Toatal iStatiu:unID: MEJRC - Tactical Call: .I:EISEEIE - THNC: KPC-3 - BES: WE<5CA iEIEI:EIEI:EIEI-!'IEI:'I?':E'I 7

(
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Features

Message viewing

. Supports viewing,
printing, deleting or
saving a message to a
local file

. Reply and Forward
message formatting

-inix]
File Edit Setup Tools bekiera Help
Newl( Openl ) Deletel Printl SEnd,l'Receivel
Folder List

T U | Type| Fin | Ta |eBs [ Subject | Date/Time | Size |

¥ ALLEOC WBXS5... EMERGENCY BBS OPER... 02/16/04 16:54 51__.
SUMMYALE HaM FLEARMAR. . 08/13/04 12:39 2770

g ! M35 b ask Purchaze 12421/04 17:41 329

Out Tray .. WBXS5_ .. Request EOC Status 12721704 23:49 249
MEWIISH  KEFE-2 YWelcome o Outpost 1.3 Mone 1443

Sent
LN

Draft
tzqz

Deleted
Mgz

9 ltems, 35 Tots

How?
1. Highlight Message
2. Press “Open’

N95 Mask Purcnase - Packet Message
File Edit Actions Help

Reply

=10l x|

Printl Forward Delete Close Expire

Bulletin Meszage
Bbs KGFB-2
From: KMNGPE

To: CARES
Subject; M95 Mask Purchase

Sent: 12/21/04 11:41

|i‘155#43 12721704 11:41 FROM EN&FE TO CARES
SUBJECT: N95 Mask Purchase
FATH: K&FB

11 Packet-enabled CABES members,
Those CABES members interested in purchasing N95 masks as described by
Marsha, please let me know. We will be doing a bulk purchase at a cost of 51

per mask for CRABES members.

regards,
Jim EN&PE

Outpost Packet Message Manager 2.1.2
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Features

Dutpnst TNLC Message Manager = |EI|5|
File Edit Setup Tools Actions Help k
NewI Openl ( Deletel ) Printl SEnd,l'Receivel
Folder List
nT L | T_I,J|:|e| From | To | BES | Subject | D ated/Time | Sizel
. Ly E  SYSOP ALLEOC WEXS.. EMERGENCY BBS OPER... 02/16/04 16:54 51
D | t M E HEVFH ALL KEFB-2  SUMMYVALE HAM FLEAMAR... 08/13/04 1239 2770
e e I n g eS S ag eS ] M35 ozl Purchaze 12421404 11:41 329
n XSCEOC CUPED... WEXS_.. Request EOC Status 12721704 23:49 249
FHEPE MEWISH  KEFE-2 Welcome to Outpost 1.3 Mone 1443
KMEPE MEWUSR  KEFB-2  ‘wWhat's Mew in Outpast 1.3 M 4108
Moves message to the e R ST
KMNEPE MEWUSR KEFBZ  WHAT'S MEW! Automaticaly.. Maone 2674
Deleted Messages folder Msgs KMEPE MEWUSR  KEFB2  WHAT'S NEW! Messagedn.. Mone 1445
(just like a trash can)
tzqz
-
. . Msgs
1 . ngh“ght Message | 9ltems, 35 Total | Station |D: KMEPE ~ THC: KPC-3 ~ BES: KEFB-2 00000 115748

2. Press “Delete’

Outpost Packet Message Manager 2.1.2
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Features

Creating Messages

* Direct Entry
» Cut-and-paste from other apps
* Import Text from a file

Outpost Packet Message Manager 2.1.2
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Workflow — How 1t Gets Done

A

Press “New” to create a new message

Compose the message.
Press “Send” — message is moved to Out Tray

Press “Send/Recelive” to transmit/receive msgs

1. Sent messages are moved from Out Tray to Sent Msgs folder

2. New messages are displayed in bold in In Tray

Read and handle new messages

Delete messages as needed

1. Deleted messages moved to Deleted Messages folder

Outpost Packet Message Manager 2.1.2




How It Gets Done

1. Click...[ . New

2. Type msqg...

3. Click...L.Send

\

IMessage stored in Out Tray|

/.

4. Click...| . Send/Receive | —— .

IMessage moved to Sent Msgs|

/
\
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Features

Message creation

. Supports Private,
Bulletin, and NTS
message types

. Message formatting
before sending

. Set messages to
Urgent

. Request delivery or
read receipts

How?
1. Press “New”

2. Type Message
3. Press “Send”

Dutpnst TNLC Message Manager k = |EI|5|
File_Edit—Sabug Tools  Actions  Help

C

Newl) Openl Deletel Printl SEnd,l'Receivel

[GE

9 ltems, 3!

Folder Li:t

5B Eile Edit Actions

L | T_I,J|:|e| Fram | Ta | BES | Subject | D ated/Time | Sizel
B SYSOP  ALLEOC W6XS... EMERGENMCY BBS OPER... 02/16/04 16:54 51__.
MEWFH BF SUMMYALE Hak FLEAMAR. . 08/13/04
LMNEPE CARES .EFB-2 M5 b ask Purchaze 24
®SCED, ... Request
Welcome

12421
Mone

=101 x|

F‘rintl Sendl Savel Closel Urg Pt ‘ Bul | MTS

Private Mezsage

Bbs [l<EFE-2

From: |KMEFE

To |KRECO

Subject |Cupedino Streams

Een,

Marsha is working with the Santa Clara Water district on getting high water
height markers on all critical waterways throughout the City. This should be
done sometime this spring.

73, Jim FN&PE

=
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Creating Messages

Direct entry

» Allows cursor placement
within the text field

» Supports TAB characters
(cntl-tab) thereby reducing
character count

 Allows text files to be directly
Imported into the message
form

25 Outpost Packet Message Manager 2.1.2

BB New Packet Message =10l x|
File Edit Actions Help
P'rintl Sendl Savel Clnsel Urg | Pt | Eul | MTS
Private Meszage; Delivery Receipt Aequested
Bbs: |WWERHSC-1
From: |CUPEODC
To: [X3CEQC
Subject: |Status of Cupertino EQC
The following operating positions are staffing at the EQOC: ;I
Director Emergency 3ervices Dawve Enapp Ti7-1234
Plamming/Intel 3ection BEob Enight TI7-2345
Logistics Section Ken Smith Ti7-3456
Operations Jection Eill Wright T77-4567
Finance Section Trudy Collins T77-5678
411 phone numbers are in the 408 area code.
Jim 0 EN&PE
! =




FA Microsoft Excel - Shelter Requirements.xls

J Eile Edit Yiew Insert Formak Tools Data Window Help

Creating JD_@_EI|§&E; 3 g_@ﬂn-n-

> A A IS

J.ﬁ.rial -lﬂvﬁf g|§§§|$x’,+@+n +_+- L .
I\/I eS S ag eS Al | =| ltern Mumber
A | B [ Cc [ b | E [ F | 6
1 |ltem Mum Description On Hand Units Qty needed Req Date Req Time
Z 1 cots a0 ea 25 18-Mar 18:00
Cut-and-PaSte fr()m 3 2 blankets 45 ea 15 18-Mar 18:00
water, 0Z bottles ottles -Ilar :
4 3 12 oz hottl 200 bott] 100 19-M 12:00
other apps 5 4 First Aid kits 3 kits 12 ASAP
b 5 Toilet paper A0 rolls 250 19-Mar 12:00
° From EXCGL h|ghl|ght the 7 £ tooth brushes 10 ea 0 ASAP
fields to be copied, then g -loix
) File Edit Actions Help
paste into an Outpost :F: F‘rintl SEndl Sa\-'el Closel Urgl F'vt‘ BuI|NT5|
m essag e 12 Urgent, Private Mezsage
: Bbs: [wExSC-1
* At the receiving station, e
hlghllght and Copy the Subject: |Shelter Material Requirements
message, then paste baCk Pleaze zend the following material to out shelter: =
. Iten Mumber Description On Hand Units Oty needed Feq Date
into Excel. Req Tine
1 cots jeln| ea 25 15-Mar 15:00
z2 blankets 45 ea 15 15-Mar 15:00
d TabS are preserved SO the 3 water, 12 oz bottles 200 bottles 100 19-Mar 12:00
4:[ First Aid kits 3 kits 1z AZAD
message can be pasted S Telmeme S ms 300 o s
back into another o meeness 0 s 2 lowmer 1m0 1
spreadsheet. o om0 o 00 leme: lsioo
[
| | Y
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Creating Messages s

Import text from a file

Open a new message
File > Open a file
Select the text file, press

Full in the Destination and
Subject.

File Edit

New Packet Message

New Packet Message

File Edit Actions Help

_1ol x|

= Clusel

Urgl Pt | Bl |NTS|

Sawve

Save &5,
NTS Mes: Select the input file nal:ne =]

Process & Lok ire | ) Documentation =] « ¢ m-
Print =) old r% message-for-doc#3.btxk - I
. w10 [Z] message-For-doc4-MTS, bxt:
Prinkt Seb vl @ message-for-doc#5-MTS. Ext
— vz ;

Close |- vBETA

|5 WehDoc

r; 120-wWelcome-Message. . bxt
[Z] 120-Whats-Mew-Message.bxt
rﬂ EEBS LM Listing Layouts, bxk
=/ Beta-Test-Status, bxk
[Z] enhnacement list. bxt
rﬂ Handshaking.bxt

=] KISS-THC, Ext

[Z] message-Far-doc#1.bxt
FQ message-Far-doc# 2. bxt

My Documents

.

iy Computer

-

-

File narne: INS azk.txt

Filez af type:

| yéxt Files[™.tst)

j Open I
= Cancel I

Z

Actions  Help

_|ol x|

Press Send when done. prin|

SEndI Savel C|DSEI

uig | Put | BL/| NTS |

Private Mezzage

Bbs:
From:
To
Subject:

KMEPE-1 /

KREPE v

MO5 Mask b

a Ccost

411 Packet-enabled CARES members,

Those CARES members interested in purchasing N95 masks as described
by Marsha, please let me know. We will be doing a bulk purchase

of 51 per mask for CARES members.

I

regards,
Jim FEMNGPE

=

at

K
S
»
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PacFORMS

What Are They?

Browser-based versions of

 City Scan/Flash Report
 Logistics Request Form

* RIMS Form (called PacRIMS)

* DOC9 form (for hospital support)

Requires Javascript to be enabled in the browser

Read and follow the red instructions

Outpost Packet Message Manager 2.1.2




"CITY SCAN" - FLASH REPORT

JavaScript Wersion for Packet Transmission
Note: This Form has been adapted from the paper form to prepare an ASCI text file for transmission via Amateur Radio Packet.
Form adapted by Phil Henderson, KFEZSQ, Mountain “iew, CA AEC.
Yer. 2.1, 12-08-06
(This form is best used with Microsoft Internet Explarer)

< Items in RED are required =

'I.1.j| Los Altos bt | 1b.) If Other is selected, Enter Entity Mame: | |
Date/Time of Contact:  2.) Date: IW| 3.}Time (Hridin - 24 Hour Time): W|
Contact Person: 4.) Marme:; gBDb Lacey | 5. Title: (Chief of Police |
Method of Contact: 6.) Phone # @I 7.) Radio Frequency: iW|
8.) HAS THE CITY BEEM IMPACTED? (check one) @ YES N
9.) HAS A LOCAL EMERGENCY BEEN DECLARED? (check one) & YES [@ls
When? 10.) Date: [3/24/2007 | 11.) Time (HrMin - 24 Hour Time): (0830 |
Who signed it? 12.) Name: |me | 13.) Title: |Chief |
14.) HAS YOUR EMERGEMNCY OPERATIONS CENTER BEEM ACTIVTED? (check one) & YES OO

15.) Can you tell me what MAJOR INCIDEMTS are occurring now? {check ong) ® o
VES MO

16.) Please Summarize INCIDENT, LOCATON and STATUS in the text areas below:

INCIDENT (Max 80 chrs.) LOCATION {Max 60 chrs.) STATUS (Max 60 chrs.)
Downtown concrete henches Main Street Benches make citizens' bottoms
16a. Sore. Citlizens revolting.
16b.
16c.
164.
1 - |
A 2 '.r
A
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5@05

14.)

15.)

16.)

16a

16h

16¢

164

16e

161.

17.)

8.)

©J City Scan Flash Report - Mozilla Firefox

Fil=  Edit  Miews Histaory  Bookmarks  Tools  Help

Elgl 1 S0UrCE T ,a’ Options

. . @

Bacl Farward Reload

@ & (G

Home  Prink

1%

ERN | @ Disable = &. Cookies ~ || €55~ | Forms ~ 'ﬂ! Images = @ Information = ‘ Miscelaneous ~ 5/ Outling ~ ;: Resize ~ ,_j" Tool

CITY 3CAN FLASH REFORT

JS—wver., 2.1, 1l2-08-06

T COPY THE TEET IN THIS WINDOW, FOCZUS THIS WINDOW, THEN:

SeleetolL SASCTI Text by ityping CEEl=L i then  CEEl=C o Copy,

HNext, RION WordPad or Notepad and DO Ctrl-V to Paste into the editor kbody.
Then D0 Zave-izs to a TEXT Document file, or Paste directly into Outpost.
Form Item numbers are followed by a colon (@)

Answers are enclosed in brackets | [ ] )

a.: [Los Ailtos]

M

[03/21/2007]

[1240]

[Eoh Lacey]

[Chief of Police]

[B00-555-1212]

[145.57]

[ves]

t [ves]

v [3/24/2007]

[0530]

[me]

[Chief]

[ve=]

t [ves]

16a-I: [Downtown concrete henches]

16a-L: [Main Street]

16a-5: [Eenches make citizens'
1gb-I: []

leb-L:
lah-5:
lao-T:
lac-L:
lac-5:
led-I:
lad-L:
lad-5:

s = = = o = e i =

W o -1 om0k L

e
- o -

o
m o L

bottoms sore. Citizens revolting.]

& YES ONoD

e

chrs.)

If of E Done

w
Q

@ YES N

®YES O D
@ YES D

STATUS {Max 60 chrs.)

Benches mwake citizens' bottoms

sore. Citizens revolting.

O YES N

After Clicking an SUBMIT, you will get a text response in a new window. In that window, do Edit->Select All, Edit-=Copy (or Ctrl-A, Ctrl-C) and paste
[Tt inta the QUTPOST window, or apen a WardPad or MotePad windaow and paste it into that and save to a TEXT Document file for later use.

[ SUBMIT: |

[ Clear Form ]

30
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Creating Messages s

Import text from a file

Open a new message
File > Open a file
Select the text file, press

Full in the Destination and
Subject.

File Edit

New Packet Message

New Packet Message

File Edit Actions Help

_1ol x|

= Clusel

Urgl Pt | Bl |NTS|

Sawve

Save &5,
NTS Mes: Select the input file nal:ne =]

Process & Lok ire | ) Documentation =] « ¢ m-
Print =) old r% message-for-doc#3.btxk - I
. w10 [Z] message-For-doc4-MTS, bxt:
Prinkt Seb vl @ message-for-doc#5-MTS. Ext
— vz ;

Close |- vBETA

|5 WehDoc

r; 120-wWelcome-Message. . bxt
[Z] 120-Whats-Mew-Message.bxt
rﬂ EEBS LM Listing Layouts, bxk
=/ Beta-Test-Status, bxk
[Z] enhnacement list. bxt
rﬂ Handshaking.bxt

=] KISS-THC, Ext

[Z] message-Far-doc#1.bxt
FQ message-Far-doc# 2. bxt

My Documents

.

iy Computer

-

-

File narne: INS azk.txt

Filez af type:

| yéxt Files[™.tst)

j Open I
= Cancel I

Z

Actions  Help

_|ol x|

Press Send when done. prin|

SEndI Savel C|DSEI

uig | Put | BL/| NTS |

Private Mezzage

Bbs:
From:
To
Subject:

KMEPE-1 /

KREPE v

MO5 Mask b

a Ccost

411 Packet-enabled CARES members,

Those CARES members interested in purchasing N95 masks as described
by Marsha, please let me know. We will be doing a bulk purchase

of 51 per mask for CARES members.

I

regards,
Jim FEMNGPE

=

at

K
S
»
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Special Message Handling

B U I I etl n S Drill Results - Packet Message =10 x|

File Edit Actions Help

—

« To create, click on “bulletin” - repy|  Forward|  Delete sl expre
when writing message. Coutetn Message )

Bbs KMEFE-1 Sent: 02/171/06 14:33

* To delete a bulletin off of the From KNGPE T
BBS To. CARES
that you originated... e e ]

. . HSG#lFI’JEfll{’ﬂE 14:33:21 FR( Do you want to delete this Bulletin off of the BES? j‘
* Retrieve the bulletin from the BBS [F7EEL: D=iil Results 3 '

ELTH: KIN&EE Press OK to issue a 'Delete Bulletin' command to

° Open the message A—— the BBS (will occur during the next BES connect),
® PreSS EXp|re We will having a debrief oif ok I Cancel EL.

Please plan on attending.

*On the next send/receive session, |~
the bulletin will be deleted off of  [ec. cupertine ases/zaces
the BBS.

Notes

* You can only delete bulletins
that you create
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Initialize the Interface

A Typical Session ‘

Connect to the BBS

A 4

Dutpust TNC Message Manager _|EI|5| PrOCGSS BU”, NTS deletes
File Edit Setup Tools Actions Help
Newl Openl Deletel GendIReceive v

Send all messages
from Out Tray

Folder List

[ Tray ; B e ; D A

41
03/06/04 12:33 2840

If Private is set

111 N3414/N4 1550 77
THE Session Manager — =] ] d,
Abort Seszion
Sent
ECHO was ON -
cud: oy EN6PE
cud:Mon off Read
Aichive MONITOR. was OFF
cud: daytine 040220105032 I
~ cud: connect EoFE-2
cmd: **% CONNECTED to E&FBE-2
[KPC3-5. 1-HM$ ] 't
91200 BYTES AVAILAELE pn
THERE ARE 13 ME3IZAGES NUMEERED Z4-675
Welcome to the LCARC packet mailbox.
3ltems, 5 Total | Station D: KNGPE - TNC: ke [ETER COMIAND: B, 1,K,L R, 3, or Help >
LM nge
=l EIpts
v Always show this window during a Send/Receive session
Retrieving Meszage List... |EII:I:I:IEI:EI4 face
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For more information

Send inquiries to...
Jim Oberhofer, kn6pe@arrl.net

Visit the Outpost website...
http://www.CupertinoARES.org/projects/outpost

Or, Google... outpost packet
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Questions?
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